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Forward 
 

About This Document 
This document is a very early version of the Editor Guide for Arcane Mapper. In its current form, it is 
incomplete and is missing information about many features, some of which you will see referenced in the 
text. I have made it available at this early state so that people interested in the product can start to gain 
insights into the tool’s design and functionality. 

The document serves dual purposes – it acts like a reference to go back to if some functionality isn’t 
clear in the tool (in this case please let me know so I can try to make said feature less confusing if 
possible) and a sort of tutorial that you can follow along with. The tool comes with a simple example 
Map – creatively named “Example” – and then looks at each area of the tool. If you have never used the 
tool before it is recommended that you follow along and try to use some of the features as they are 
presented. 

 

Arcane Mapper Goals 
The first goal of Arcane Mapper is to allow people of all skill levels to create nice looking, atmospheric 
encounter-scale Maps for Role Playing Games, both physical (at the tabletop) and virtual (using 
something like Roll20 for example). To this end, the tool is based around the idea of using 2D art – 
images representing objects in the world – and placing that objects into a 3D forced-perspective 
environment that is created by drawing out rooms in 2D, like floor plans. These disparate elements are 
visually merged together using ambient occlusion, lighting and shadows.  

If you have little artistic skill you can use textures and images freely available online – and even with 
these basic resources the tool allows you to create atmospheric environments that your players will 
enjoy. If you do have artistic skills, then you can easily create your own assets and use them instead. 
And if you are so inclined, you can save out the Map as a .PSD and apply your final, hand crafted touches 
in Photoshop or similar tools. 

Another longer-term goal of Arcane Mapper is to allow different types of Maps to be created, such as 
regional maps, cities and world maps. 

And finally, in the future I plan on adding support for using Arcane Mapper as a Digital/Virtual tabletop. 
This has many advantages over simply using it as an editor such as real time lighting for your players, 
high quality fog of war (including options such as the ability to show previously explored areas but hide 
changes made since last seen), the ability to move objects around during play while maintaining the 
same visual quality and the ability to zoom in and out while maintaining resolution. 

As a final word, I will say that I am building Arcane Mapper for myself as a GM as well as a product – so 
that anyway I make this product better, with your help, also makes my life easier and the quality of my 
games that much higher. 
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Layout 

 

The main work area for the Arcane Mapper tool is the Map Window. This window takes up most of the 
space and by default has a square grid displayed, though Horizontal and Vertical Hex grids are also 
available. It is also possible to disable the grid entirely. 

Sitting on top of the Map Window is the Tool Window which consists of several Tabs – Library, Layers, 
Rooms, Doors and Lighting. If you are first starting out, open the “Example” map to continue following 
along. it will look like the image above. To open a map, go to the File menu then select Open. In the file 
dialog select “Example” and hit the Open button. 

Quick Hotkeys: 
F1 – Save,   F2 – SaveAs 
F9 – Toggle Fullscreen, F10 – Toggle UI, F11 – Take Screenshot 
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Map Window 
 

The Map Window is the entire gridded area shown in the Layout above. This is where Rooms are drawn, 
objects are placed and manipulated. There is a common set of controls for scrolling around the map and 
zooming in and out. Other controls, such as manipulating objects or drawing rooms, will have their own 
sections. 

The controls described below manipulate the camera and they do not affect the Map itself in any way. 
Camera controls are locked when the mouse cursor is outside of the application window, when the 
cursor is inside the Tool Window or when certain windows are open such as the File Dialog and Settings 
Window. 

The grid only extends to the Map boundaries, which can be set in the Settings Window – the default is 
25 x 25 Units in size. Anything outside of the Map boundaries will be clipped (not shown) when 
Rendering the Map to image(s), pdf or when printing. 

Moving Around the Map 
The easiest way to move around the map is to middle-click and drag, CTRL+right-click and drag also 
works. If you are in this mode, the cursor will change from an arrow to a hand. This allows for the most 
precise control and combined with the mouse wheel (see Zooming) allows for complete navigation using 
only the mouse. 

You can also use the Arrow keys or WASD keys to scroll around the map. Scrolling speed is adjusted based on the 
zoom level, so zoom out to scroll quickly and zoom in to scroll slowly.  
 

Zooming 
It is also possible to zoom in for a closer look or zoom out to get a broader overview of the map. There are two ways 
of zooming – using the +/-  keys or using the mouse wheel. The view zooms so that the area of the map covered by 
the mouse cursor is locked in place. This means that if you want to focus on a specific area while zooming, place the 
mouse cursor over that position. To reset the zoom level to default, select Reset Zoom in the View menu or hit the 
Home key. 
 

Changing the Grid 
The Grid can be changed. Changing the color and opacity must be done in the Settings Window, the type can also be 
changed there. However, you can quickly change the Grid Type in the Map Window by using the Ctrl + G shortcut 
which toggles between the Grid types: Square, Horizontal Hex, Vertical Hex, No Grid. The current Grid settings are 
saved with the Map. 
 

[Future] 
*Before the initial release, or shortly thereafter, controls and shortcuts will be rebindable. For now, you 
must use the controls as-is. 
*More Grid options such as dashed lines and points. 
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The Library 
 

Arcane Mapper uses images for objects, lights and textures for floors and walls. These images, 
collectively, are known as your Library. There are three main actions you take involving your Library – 
adding new images, changing settings for specific entries and placing objects into your maps.  

 

Adding New Images 
Adding new images to your library is simple. Navigate your hard drive to the directory that contains the 
images. Select the images and drag them over the Arcane Mapper window. If you drag them over the 
Tool Window or have more than one image selected, they will only be added to your library. If you drag 
a single image and place it on the map than the object will be added to your Library and placed in the 
map at that location. If the image already exists in your Library, the original image and settings are used; 
if it is a new image then it is added to the Library with default settings. 

[Future] For release I am planning on adding a method of finding free art assets online and adding them 
(similar to Roll20). This is needed since the program will not be packaged with many assets but with all 
of the art available, free for private use, this should not greatly impact your ability to make nice looking 
maps for your games. However, this won’t be available for the Beta but I will pre-package the free assets 
I am using. These assets cannot be sold. 

 

Change Settings 
The default settings usually work fine but they make certain assumptions. For example, Arcane Mapper 
assumes that images are sized at 105 pixels per unit (more on this below). If you download art off the 
internet or want to have more detail for printing – this may not be ideal. There are many other settings 
that you may want to change as well. 

Basic Settings 

 

There is a lot of information displayed whenever something in your Library is selected. 

Dim The dimensions of the image, in pixels. 

Size The size of the object in Pixels Per Unit. This tells the editor how to convert from pixels in the 
image to units on the map, where 1 unit = 1 grid cell. This will usually be 5 feet, 3 feet (1 yard) or 1 
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meter depending on the system. In the case of this barrel, 200 pixels maps to 1 unit on the map, making 
this barrel about 1 unit in size. If this is confusing, don’t worry too much – see Use Selected Size below. 

Use Selected Size This button automatically fills in the Size based on the scaling of the currently 
selected object on the map. So, if you don’t know how to figure out the proper Pixels Per Unit value, 
place the object on the map, scale it to the desired size and then hit the Use Selected Size button. Once 
you do that the new size will be used whenever you place that object in the future. 

Reset Size  This reset the object back to the default size – 105 Pixels Per Unit. 

Light Source  Check this if you want this object to act as a light source. This is useful for 
torches, fire pits and other sources of light. When you check this a default light color will be assigned 
and shadowing will be disabled. You will be able to re-enable shadowing and adjust the color and range. 

Light Radius In Units This is how far the light shines in Units (remember 1 Unit = 1 grid space). For 
example, if you set the Light Radius In Units to 10 then the light will shine 10 Units in every direction. 

Light Color  If you click on the colored box a color picker will be opened where you can 
select the desired color. You can also select the Eye Drop and click anywhere on the image to the left if 
you want the color to match part of the image. 

Casts Shadows Enable this if you want the object to cast shadows. This defaults to true unless 
the object is a light source. 

Dual Height  [Not yet implemented] This is an alternate way of generating shadows for the 
object. Instead of assuming the object is being rendered top down, it assumes the object is viewed from 
the side. 

Height in Units This is the height of the object in Units, this value is used when generating 
shadows. 1.5 units is about the height of a character, 1.0 is good for crates and barrels. Smaller values 
make the objects appear shorter when casting shadows, larger values make them taller. 

Advanced Settings 
If you select Advanced in the upper left corner, you will get some additional settings. More less 
frequently used settings will be added in the future. 

 

Texture This indicates that this image is used as a texture for floors and walls. This will resort this 
image to the end of the Library and cause it to show up under the Rooms Tab so it can be used to 
change the floor or wall textures. 
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Snap To Wall This object will re-orient to the nearest wall, if it is overlapping a wall on the map. Use 
this for objects like torches so that they can be quickly placed on walls. 

Decal  This object will be flattened and aligned with the nearest wall, if it is overlapping a wall 
on the map. Use this for wall decorations such as holes, paintings, wall grime and other details. 

 

Placing Objects 
Placing objects in your maps can be done in a few different ways. 

The simplest and most intuitive method is to simply drag and drop images from the Library Tab right 
onto the map. When doing this the object will be partially transparent so you can drop it wherever you 
like. 

The second method is to select the desired object and Shift + Right Click with your mouse wherever you 
want to place it on the map. This allows you to place objects very quickly, useful when you want to place 
a lot of something, like barrels, boxes or debris. If you select an object on the map it automatically 
selects it on the Library Tab, so you can select an object on the map and Shift + Right Click to place that 
object in other places. Note this is not a copy or duplicate, see Manipulating Objects in the Map Window 
for more details on that type of interaction. 

[Future] 

In the future randomized rotations, will be implemented so you can place objects quickly while looking 
more natural. In addition, being able to randomly select between a set of objects will also be 
implemented – this will be great for outdoor environments – so rocks, trees and other features can be 
quickly placed. 
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Manipulating Objects in the Map Window 
 

One of the most common things you will be doing is manipulating objects in the Map Window. To 
manipulate an object, first it must be selected. To select an object Left-Click with your mouse when the 
mouse cursor is over the object. Note that objects are selected using a Pixel Mask – this means that you 
must click on a solid visible area of the object to select it. This might make selecting slightly harder in 
some cases but in the clear majority of cases it makes selecting things much easier. For example, if you 
place a small knife on a table, selecting the knife is easy – since you will only select an object if you click 
on a solid, visible part of it. Once an object is selected it will have a blue box drawn around it. 

To move an object simply Left Click the object and hold the Left mouse button. By default, the object 
will snap to the grid, this can be disabled in the Settings Window (see Settings). If the object is placed 
inside a Pit it may be rescaled based on depth (see Drawing Rooms). 

If you hold the Alt key while moving, rotating or scaling then snap settings are ignored, this is a quick 
way of freely placing or moving a few objects without having to disable snapping each time. In addition, 
if you need to make fine adjustments while moving objects, you can use the arrow keys to nudge them 1 
pixel at a time. 

To make other adjustments, select the object and open the Edit Menu or Right Click Menu. To access 
the Right-Click Menu simply Right-Click on the selected object with the mouse. 

 

You will notice that each operation has a shortcut associated with it, these shortcuts can be used to 
quickly apply these actions without needing to use the menus. 

Cut  Make a copy of the object and then delete it. A copy of the object can then be pasted. 

Copy  Copy the object so it can be pasted somewhere else. 
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Paste  If an object has been copied this will paste it where the mouse is located. 

Duplicate Duplicate the object in place, useful for making quick copies that are used near the 
original location. 

Delete  Delete the object from the Map. This does not delete it from your Library. 

Translate Change the object control to Translate – which is the default movement mode. 

Rotate  Change the object control to Rotation – this allows you to rotate the object (see 
Rotation below). 

Scale  Change the object control to Scaling – this allows you to uniformly or non-uniformly 
scale the object (see Scaling below). 

Flip Horiz Flip the object horizontally. This is not the same as rotation since it mirrors the object 
horizontally. 

Flip Vert Flip the object vertically. This is not the same as rotation since it mirrors the object 
vertically. 

Move Up Move the object towards the top of the stack. This means that if multiple objects are 
overlapping, it will shuffle it upwards towards the top. 

Move Down Move the object towards the bottom of the stack. This means that if multiple objects 
are overlapping, it will shuffle it towards the bottom. 

The Edit Menu offers additional functionality such as Undo and Redo.  

 

Rotation 

 

This control allows the object to be rotated. By default, rotations snap to 22.5 degrees (i.e. it snaps to 16 
directions) but this can be changed or disabled in the Settings Window (see Settings). To rotate the 
object Left Click on the Orange Square and hold the mouse button down while moving the mouse to 
another place on the circle. You can also just Left Click on the circle to rotate to that direction instantly. 
Note that the center of rotation is marked by the X in the center of the circle. 

It is recommended that you use a snap of 22.5 degrees for square grids and 30 degrees for hex grids. 
This allows for a decent number of rotations while allowing the object facings to match the grid exactly. 
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Scaling 

 

This control allows the object to be scaled. By default, scaling factors snap to increments of 0.5 but this 
can be changed or disabled in the Settings Window (see Settings). If you use the left or right handles, 
the object will be scaled horizontally only. If you use the top or bottom handles it will be scaled vertically 
only. If you use the corner handles, it will be scaled both horizontally and vertically by equal amounts. If 
you hold Ctrl + Left mouse button, then the corner handles scale horizontally and vertically at the same 
time but non-uniformly, i.e. if you move to the right more than down, the object will be stretched. 
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Layers 
 

 

 

The Layer Tab in the Tool Window allows you to 
switch between Layers, change their names and 
move them up and down. At this early stage 
Layers above the third (Props) do not function 
correctly yet, so adding and removing Layers 
should be avoided until this is finished. For the 
Beta, the useful Layers are the Environment, 
Environment Details and Props. Right-click on a 

Layer to change its name, Left-click to switch to that Layer. 

When a Layer is selected, objects in higher layers become transparent on the Map. Objects are rendered 
from the bottom Layer upwards, so objects in the Environment Layer will be rendered first – after the 
rooms themselves – followed by the Environment Details, Props and so on. Only objects in the current 
Layer can be selected and manipulated on the Map. 

Objects in the Props Layer (and higher Layers in the future) are lit, cast shadows and ambient occlusion. 
Objects in the Environment Details and Environment Layers use the Room lighting directly and do not 
cast shadows on their own. These layers are great for objects that should be sitting on the floor or walls, 
like carpets, dirt and grime. 

In the “ThroneRoom” map you will notice that, 
when the Props Layer is selected, you cannot 
select the carpets in this area. These carpets 
are on the Environment Details Layer. Notice 
also that they inherit the lighting from the 
floor and walls, as evident by the top carpet 
appearing to hang over. 

This map has several floor and walls details in 
the Environment Details Layer, such as grime, 
mold and other types of carpet. 
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In the screenshot below you can see the mold under the skull pile, the dirt on the floor by the barrels 
and carpets on the left side of the screen. Since the Environment Details Layer inherits the lighting from 
the floor and walls, they merge in and become details. 
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Room Editing 
 

Rooms are created by drawing out the shapes. To start Open the “Examples” map and then select the 
Rooms tab on the Tool Window. Before drawing out new rooms, let’s see how to edit one first. When 
the Rooms tab is open, you will notice that white lines are drawn around the room. This is the actual 
shape of the room, which marks out the floor. Select the Edit Mode in the Rooms Window. You should 
see this: 

 

 

If you mouse over the room, you will notice that the lines change to an Orange color. To edit its 
properties, you will need to select the room. This is done by left-clicking on the highlighted Room. If a 
room is selected the color of the lines will change to cyan and you will see a lot more options in the 
Rooms tab.  
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If you want to change the shape of the room, mouse over one of the vertices -  the small orange squares 
– and press and hold the Left Mouse Button. When you let go, Arcane Mapper will rebuild the room 
based on the new shape. 

To change the floor texture, click on Floor in the Current Room area and it will highlight. Then click on 
one of the textures towards the bottom of the screen. In a similar way, you can change the Wall texture 
as well. Currently changing Wall Top does nothing useful but later that will change what the tops of the 
walls look like. 

You can change the height of the walls by clicking in the Height/Depth edit box and changing the 
number. Any value larger than 0 will work but wall heights much beyond 32 or 48 don’t work as well, 
since the walls can self-intersect and the textures repeat too much vertically. A height value of 1 or 2 
gives you very short walls, good for tightly packed indoor environments. Larger settings, such as 32 work 
well when you want to emphasize the walls; 16 seems to be a good sweet spot but use whatever you 
think looks best. 

It is possible to change the type of room, from regular Room, Pit and Raised Platform. These don’t make 
sense for a single room but work well when drawing out pits and raised areas inside of existing rooms. If 
you are editing a Pit, you can also setup height fog. To do that hit the Fog checkbox and set the 
minimum and maximum height. By default, the minimum should be 0 and the maximum the 
Height/Depth of the room. Make sure the change the color and opacity to see the fog. 

To create new rooms, switch back to Draw Mode and make sure you have some empty space to draw in. 
Now there will be a cyan square near your mouse pointer whenever it is over the Map Window. You will 
notice that the square snaps to specific locations, based on the snap to grid settings. Left click to start a 
line and continue left click in different locations to draw a shape. Once the shape is complete, Left-Click 
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on the first vertex (point) or Right-Click. This should complete a room and you should see the floor and 
walls appear. At this point you can select it in Edit Mode, if you want, to change settings. 

 

Connecting rooms is really simple. In the image above you see a room and a hallway. I drew those out as 
two different rooms as discussed above. To connect them, draw a square in the space in-between the 
room and hallway that touches lines from both. This will create another room that connects these two 
rooms. See the image below, which should help clarify what I mean. 
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Notice the highlighted square room in-between the two. Whenever you draw a new room that shares 
edges with existing rooms, Arcane Mapper automatically connects the shared edges and builds the 
correct walls. 

Next, we’ll add a pit to the bigger room. To do that draw another shape completely inside the room. 
Once finished it will automatically become a Pit. You can go to Edit Mode to change the depth of the Pit, 
add fog or change it into a Raised Platform instead. 
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In the screenshot above, you can see I added the Pit, made it 32 units deep and added gray fog. 

 

Finally add some objects with lights, ground details in the Environment Details Layer such as dirt and 
moss and the rooms become a lot more interesting. Remember that Ctrl-G changes the grid mode. 

 


